
  
  
  

  پنجم  بخش
  ETABSافزار   طراحي حالت حدي در نرمةمثال كاربردي از نحو
   نتايج طراحي حالت حدي و تنش مجازةبا مقايس

  
  
  
  
  

 افـزار   نـرم  فلزي با سيستم دو طرف قاب خمـشي در           ةك ساز يبراي  دو روش حالت حدي و تنش مجاز        نتايج طراحي با     ة مقايس در اين بخش  
ETABS v.9.6 شود مي انجام.  

 توضيحات بخش چهارم اين كتاب منطبق با بر اساس كه AISC 360-05/IBC2006 ةنام روش حالت حدي از آيينه ها ب براي طراحي سازه
  .، استفاده شده استاستضوابط طرح حالت حدي مبحث دهم 

عـدم نيـاز بـه در نظـر گـرفتن       اما به لحـاظ  ،شود مي هر دو روش تنش مجاز و حالت حدي را شامل ،AISC 360-05 ةنام آيينهرچند كه 
 ـ   براي طراحي سازه، با مبحث دهمAISC 360-05 ةنام اي در اين پروژه و نيز عدم انطباق بخش تنش مجاز آيين الزامات طرح لرزه روش ه هـا ب
مبحـث دهـم   روش منطبق بـا بخـش تـنش مجـاز     اين نامه در  مندرجات اين آيين. ( است استفاده شدهAISC ASD-89 ةنام تنش مجاز از آيين

  .)مشابه است ،منتشر شدهAISC 2001 از قبيل AISC كه بعد از آن توسط يهاي نامه آيينبا ساير  و است 1387ويرايش سال 
 لحـاظ  ةنحـو  و ه داده شـد شـرح در بخش سوم كتاب در قالب تنش مجاز و به صورت كنترل دستي        قبلا  اي مبحث دهم     ضوابط طرح لرزه  

 مراحل سازي سادهبنابراين در اين بخش به منظور  . داده شده استشرحر حالت حدي نيز در بخش چهارم         د ETABSاي در    ضوابط طرح لرزه  
  .اي صرف نظر شده است طراحي و مقايسه، از ضوابط طرح لرزه



  
  
  

  فصل اول
  ETABS تحليل و طراحي سازه به دو روش حالت حدي و تنش مجاز در ملاحظات كلي

  
  
  
  
 
  ل انجام پروژهمراح -1-1

 دو فايـل مـدل    نهايتـاً ، از آنكـردن  و كپـي  ETABS v.9.6 افزار نرم طبقه در 5 متوسط  فلزي قاب خمشيةسازي يك ساز پروژه با مدلدراين 
 سازه را براي هر يك از اين دو روش ،ها در هر كدام از فايل  يكسان براي دو فايل،ةاي يكسان خواهيم داشت كه با بارگذاري ثقلي و زلزل سازه

  .ه و سپس نتايج ناشي از طراحي براي مقاطع تير و ستون در دو فايل مورد بررسي قرار داده خواهد شدطراحي نمود
 1387 نتايج حاصل از دو روش طراحي مندرج در فصول اول و دوم از مبحـث دهـم ويـرايش سـال     ة تنها مقايس،از آنجا كه در اين پروژه    

)،5 انتخاب ضريب رفتار طراحي سازه برابر        اي با   بنابراين بررسي ضوابط طراحي لرزه     ،استمدنظر   5)R  مطابق توضـيحات ابتـدايي بخـش        =
  .نيست مؤلفيناي مورد توصيه   هرچند كه انتخاب اين روش جهت حذف طرح لرزه،است صرفنظرسوم مبحث دهم، قابل 

اي بيش از مقـدار     تا سازه را براي نيروي زلزله      ،ست ا قع، سعي بر آن    از وا  تر  كوچك برابر با مقداري     ،در واقع با انتخاب مقدار ضريب رفتار      
سـت در ايـن حالـت بـا          ا  در عوض بديهي   .شود الاستيك بيشتر فراهم     ة امكان ورود سازه به منطق     كار  اين تحليل و طراحي نماييم تا با        ،معمول

  . سلب خواهد شدةپذير ساز  امكان طرح شكل، مقاطع اعضاءكردندست بالا طرح 
ها، اين بخش تركيب بارهاي تشديد يافته، الزامات تير          الزامات عمومي ستون  : بنابراين در اين پروژه از تمامي الزامات موجود كه عبارتند از          

 نتايج دو ةگرديده است و مقايسصرفنظرمندرج در بخش سوم مبحث دهم    ... اي بودن مقاطع و      و ستون در قاب خمشي متوسط، فشردگي لرزه       
  .اي مربوطه صورت گرفته است  جهت سادگي بدون لحاظ الزامات اضافي طرح لرزه،يروش طراح
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  ETABSسازي سازه در   مدل -1-1- 1

ارتفاع طبقـات   .است IMF طبقه و خرپشته با سيستم دوطرف قاب خمشي متوسط           5 داراي   1-1 مورد بررسي در اين پروژه همانند شكل         ةساز
  .است متر و روش تحليل در هر دو روش طراحي، استاتيكي معادل 2.7 ع پاركينگ و خرپشته متر و ارتفا3به جز پاركينگ و خرپشته برابر 

 
   فلزي با قاب خمشي متوسطةنماي سه بعدي از ساز -1-1 شكل

  
  )Define( تعريف مصالح و مشخصات سازه -1-1-2

Define>Material  
yF/ 22400 با مقاومت تـسليم St−37 از نوع ،ها  ورقوها،  فولاد مصرفي در تيرها، ستونمصالح  2-1مطابق شكل  kg cm=    و مقاومـت نهـائي

23700 /uF kg cm=،    210و مصالح بتن باcf  ـ         شدند مربع تعريف    متر  سانتي كيلوگرم بر    = ي بـا جـرم      و علاوه بر آنها مصالحي از نوع بتن ول
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  .شودهاي بتني انجام   تا در تعريف سقف، بارگذاري بار سقف با حساب بار تيرچهشد تعريف Conc0واحد حجم برابر صفر با نام 
  

  
  واحد حجم صفرم تعريف مصالح بتن با جر -2-1 شكل

Define > Frame Sections 
هاي جداگانـه بـراي تيرهـا و     Auto Selection با تعريفpro.* موجود با پسوند ة مقاطع از مقاطع آمادكردنيف مقاطع پس از وارد در تعر

  .شود ها و تيرها انجام مي براي ستون Beam و Column  با نام3-1ها تعريف مقاطع مطابق شكل  ستون
  

  
  ETABS در Auto Selectionتعريف مقاطع  -3-1 شكل

Define > Wall Deck Sections 
  .كنيم ي تعريف م4-1مطابق شكل   و نوع مصالح را آن از نوع بتن با وزن صفرFilled Deckنوع سقف را از نوع تيرچه بلوك تو پر 
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 تعريف نوع مقطع سقف تيرچه بلوك -4-1 شكل

 تا به اين ترتيپ پيچش ناشي از بارهاي ثقلي نيز در سازه بـه  ،استها بين تيرها توزيع سقف از نوع شطرنجي    بار تيرچه  ةجهت توزيع بهين  
 تيرريـزي  ة زاويAngel در قسمت Assign > Shell/Area > Local Axis ةها با مراجعه به گزين ر با انتخاب سقفبراي اين منظو. حداقل برسد
  .كنيم  درجه تعريف مي90 و 0 هاي مختلف سقف را در قسمت

Define > Mass Source 
 كه بـراي    )Wall( ديوار   ة بار متعادل كنند   سازي در تركيب بارهاي موجود در اين سازه از تركيب بار ناشي از             به جهت كاهش تراكم و ساده     

 شده صرفنظر)  و سقف پاركينگيناشي از توزيع نامتعادل بار ديوار به تيرهاي بالايي در سقف انتهاي       ( توزيع يكسان و تعيين صحيح مركز جرم      
 Dead +0.2Live برابـر 5-1 شـكل   مطـابق واي و مركز جرم سازه سهيم  با فرض كاربري مسكوني اين سازه باري كه در تعيين جرم لرزه.است
 .است
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 اي سازه  در تعيين جرم لرزهسهيمتعريف بارهاي  -5-1 شكل

ه به نوع  بستكه آن علت به Load Combination و تعريف تركيبات بار Load Cases شامل تعريف نوع بارها Defineهاي منوي  ساير گزينه
  .هاي مربوطه توضيح داده خواهد شد  در قسمت،هاي متفاوتي در آن به كار برده شود  گزينهبايد ،طراحي

 در نظـر گـرفتن اثـر    بـراي كه  Special Seismic  Load Effect ة از گزين، براي طراحي سازه5همچنين به دليل انتخاب ضريب رفتار برابر 
  . شده استصرفنظر در اين منو استهاي تشديد يافته اي در تركيب بار  مقاومت سازهةاضاف

  
  )Assign (تخصيص مشخصات سازه -1-1-3

Assign > joint/point > Diaphragm 
 بـا اعمـال بـار       كـار   ايـن با  . كنيم  اجزاي سازه را به هم وابسته مي       ة هم ،با انتخاب تمام اجزاي سازه از منوي بالا با تعريف ديافراگم كف صلب            

 نقـاط طبقـه   ة اعمال بار بـه هم ـ ة، به جهت ديافراگم بودن طبقه، اعمال بار به مركز جرم طبقه به منزلUser Cofficient جانبي زلزله به صورت
  .خواهد بود

Assign > joint/point > Restraint  
 آزادي انتقالي دوراني سـازه در كـف بـسته    ة درج6زنيم تا هر   علامت گيردار را مي،هاي كف سازه و از منوي بالا       پس از انتخاب همه گره    

  .)استسازه در دو طرف قاب خمشي ( شود
Assign > Frame/Line > End Length Offsets 
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 0.5  صـلب انتهـايي را برابـر   ة بالا، درصد ناحي ـة انتخاب گزينو) Select > Select By Line Object Type > Beam(  تيرهاةبا انتخاب كلي

كه البته اينجا اتصالات سازه در هـر دو طـرف   (كنيم   صلب انتهايي را مشخص مية، در واقع طول ناحيRigid Zone Factor =0.5 كنيم وارد مي
  .)استصلب 

Assign > Frame/Line > Frame Releases 
 بنـابراين بـا     ،تنيـس  لذا نياز به كاهش هيچ مماني در محل اتصال هيچ كـدام از تيرهـا                 ؛استاز آنجا كه سيستم سازه در دو طرف خمشي          

  .كنيم  در قسمت پايين را فعال ميNo Releases، تيك 6-1 اجراي منوي بالا، مطابق شكل  تيرها و سپسةانتخاب هم
 تمامي تيرها از ابتدا به صـورت  ، فعال باشد Continuous عبارتMoment Releases مربوط به كشوي ةچنانچه در هنگام ترسيم تيرها در جعب

  .شوند  فعال باشد، تيرها دو سر ساده  تعريف ميPinned ةچنانچه در اين كشو گزيندو سر گيردار يا 

   
  هاي خمشي تعريف دو سر گيردار بودن تيرهاي قاب -6-1 شكل

  
  خصات بارگذاري سازهمش -1-2
  بارگذاري ثقلي -1-2-1

  : طبقاتةبار مرد
 كيلوگرم بر متر مربـع  150 دست بالا  كه مقدارشودمحاسبه  بايد ،صورت سربار معادل ه در محل قرارگيري تيغه ب  سانتي داخلي  10 يها بار تيغه 

  بـام ة بار مـرد و 550طبقات  ةبار مرد .آيد  بدست مي نهايي طبقاتةبراي آن لحاظ شده است و از جمع اين بار با وزن سقف دال بتني، بار مرد        
  .شود مي كيلوگرم بر متر مربع منظور 600  قيرگوني در بام مقدارةبه جهت نياز به دولاي
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 : راه پلهةمردبار 

 مجازي سـطح  كردن  يك روش مدل،جهت توزيع بار راه پله  . شود  مي كيلوگرم بر مترمربع منظور      700 راه پله در جهت اطمينان       ةمقدار بار مرد  
 وارد و  ، راه پله به سطح دال مربوطـه در طبقـات          ة تا بار مرده و زند     ،)البته با بتن وزن صفر    ( است Deckراه پله در محل بازشوهاي هر طبقه با         

  .سپس به تيرهاي كناري منتقل شود
  
 :زنده بار

2150ميزان بار زنده در بام برابر • /kg m؛ است  
2200ر زنده در طبقات مسكوني برابرميزان با • /kg m ؛است  
2350ميزان بار زنده در راه پله برابر • /kg mاست .  

  
  :بار برف

 150 آب و هـواي بـا بـار بـرف            3 ةبا فرض ساخت ساختمان در تهران از آنجا كه طبق مبحث ششم مقررات ملي ساختمان، تهـران در منطق ـ                  
 بـام منظـور     ة كيلوگرم بر متر مربع بـراي بـار زنـد          150 مقدار حداكثر يعني     ، بام ة بار برف با بار زند     ةاز مقايس  .استم بر متر مربع واقع      كيلوگر

  .شود مي
  

  :بار ديوار پيراموني
اي تيرهاي پيراموني طبقات دوم تـا  بنابراين بار ديوار بر. شود مي منظور ، كيلوگرم بر متر مربع سطح ديوار250بار ديوار پيراموني مقدار حداكثر     

250 متر و نيز تيرهاي كنار راه پله برابر با         3چهارم به ارتفاع     3 750×  كيلوگرم بر واحد طول تير خواهد بود كه براي تيرهاي بام تنها نـصف               =
  . كيلوگرم بر متر375 يعني مقدار ،شود مياين بار اعمال 

250كل بار برابر    متر، 2.7 فاعبراي ديوار پاركينگ با ارت     2.7 675× خواهد بود كه فقط نصف بـار ديوارهـاي         كيلوگرم بر واحد طول تير       =
  . خواهد بود337.5مقدار آن شود كه   اول منتقل ميةپاركينگ به تيرهاي طبق

  : طبقات مختلف بر شرح زير است برايپله بنابراين بار ديوارهاي پيراموني وارد بر تيرهاي پيراموني و تيرهاي كنار راه
  ؛كيلوگرم بر متر 687.5=750/2+37.5 اول برابر ةدر طبق •
  ؛ كيلوگرم بر متر750سوم و چهارم مقدار   دوم،ةطبق •
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 .است كيلوگرم بر متر 375 بام مقدار ةو طبق •

 

V.بارگذاري زلزله -1-2-2 C W= 

 .كنيم  استفاده مي3-13به طور خاص بند  و 2800 ةنام جهت بارگذاري زلزله از آيين

 كـه بـا   شـود   تهران فرض مـي  شهرةمحل پروژ. است 5ضريب رفتار قاب خمشي با هر دو جهت    سيستم مقاوم در برابر بارهاي جانبي در        
0.35A در نتيجه  وزياد  خيلي  خطر نسبي    g=)   خـاك نـوع      ،2800س اسـتاندارد    همچنين نوع خاك منطقه براسا    . است) شتاب مبناي طرح III 

0.15با secoT = ،0.7 secsT 1.75S و=   .است =
  .است متر 14.7  برابر)استسطح پلان سازه  %25مساحت خرپشته كمتر از ( ارتفاع سازه بدون حساب خرپشته

14.7H m=     ( )3/ 4
0.08 14.7 0.6 secT = × =  

0.35A 1I    و    = )    و = )
0.15,    0.7 ,    1.75

( 1) 1 1.75 2.75
o s

o s

T T S

T T T B S

= = =
< < ⇒ = + = + =

  

5R =    0.35 2.75 1
0.1925

5

ABI
C

R

× ×= = =  

 ـدر فصل سوم اين بخش       .است محاسبه شده بر مبناي ضريب رفتار سطح تنش مجاز           ةضريب زلزل  اي طراحـي در روش حالـت حـدي         رب
  .شود مي ضريب رفتار در حالت نهايي تعيين و ضريب زلزله اصلاح ،نهايي

 
 Load Cases تعريف انواع بار -1-2-3

  Live وxE Dead وyE:عبارتند از شد،چهار بار اصلي كه تعريف 

سازي به صـورت تـصحيح در بارهـاي اختـصاص يافتـه بـه تيرهـاي            در حين مدل  ) Wall(دل كننده ديوار     كه گفته شده بار متعا     طور  همان
  .شدپيراموني وارد 

كـه   ypE و   xpE و ynE اما جهـت اطمينـان بارهـاي       ،استهرچند كه در اين سازه به وضوع منظم بودن سازه در پلان و ارتفاع قابل تعيين                 
  . استشده بار زلزله مربوط به روش تنش مجاز تعريف 7-1در شكل  .شد تعريف ،است %5حاوي بار زلزله با برون محوريت 
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  %5 تخصيص بار زلزله با بروم محوريت تصادفي ةنحو -7-1 شكل

تعريـف آن در قـسمت      جزئيات  و   x  و y  در دو جهت   NDead و   NLive هاي بار  حالت حدي  روش  به بار مربوط به طراحي      هاي  حالتر  د
  . از همين فصل توضيح داده خواهد شد1-5
  
 ETABS بارگذاري سازه در  گرافيكيخروجي -1-2-4

 روي تيرهـاي پيرامـوني و   ، ديوارةبار مرد و زنده،  مردهسقف شامل بارقاب و   چند نمونه از   بارگذاري صورت گرفته بر روي      8-1اشكال  در  
 .هاي اطراف راه پله آورده شده استتير
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  چند نمونه از قاب و سقفرگذاري بار مرده و زنده در خروجي گرافيكي با -8-1 شكل



  
  
  

  فصل دوم
  ASDپارامترهاي طراحي سازه به روش تنش مجاز 

  
  
  
  
  

 تنظيمـات   ةاين فصل به صورت خلاصه تنها به نكات برجـست         در   بنابراين   ؛آيد  روش سنتي طراحي به حساب مي      ،طراحي به روش تنش مجاز    
  .شود مي پرداخته  روش به اينطراحي

  
  AISC-ASD 89  طراحيةنام مشخصات آيين -2-1

Options > Preferences > Steel Frame Design 
 نـوع قـاب را      1-2در اين صـفحه مطـابق شـكل          .كنيم  ميروش تنش مجاز انتخاب     ه   را براي طراحي ب    AISC−ASD89 ةنام از منوي بالا، آيين   
Moment Frame كنيم مي انتخاب:  

بـه تركيـب بـار داراي    افزار   نرمنامه، هنگامي كه نفرض تنظيمات آيي    طبق تعريف در پيش    ؛ استفاده شود  AISC ةنام  از آيين  ETABSچنانچه در   
بـار را بـه      0.75 ضريب كاهش    ةبرنام.  و لازم نيست كه اين ضريب در تركيبات بار وارد شود           شود  ميرسد، افزايش تنش مجاز لحاظ       زلزله مي 

  .كند مي تنش مجاز لحاظ 1.33 صورت افزايش
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 ETABS در AISC ASD89 ةنام  انتخاب آيينةنحو -1-2 شكل

  
  ق مبحث دهمفلزي مطاب هاي سازهطراحي تركيبات بار  -2-2

 در تركيـب    بـراي ايـن منظـور      . سازه در دو امتداد عمود بر هم در برابر بارهاي جانبي محاسبه شـود              بايد ،2800 ةنام  از آيين  4-1-2مطابق بند   
مطابق مبحث دهم بـراي طراحـي در روش         بنابراين  .  عمود بر آن تركيب كرد     ة بار زلزل  %30 بار زلزله را با      %100 بايد زله،بارهاي شامل بار زل   

  . آورده شده است1-2 كه در جدول  تركيب بار داريم34 حداكثر  جمعاً، قائمةتنش مجاز بدون احتساب بار زلزل

  ASDتركيبات بار در روش تنش مجاز  -1-2 جدول
Dead              /   Dead+Live  
D+L +Exp+0.3Ey  /   D+L - Exp+0.3Ey  /  D+L + Exn+0.3Ey /  D+L-Exp+0.3Ey  
D+L +Exp-0.3Ey  /  D+L – Exp-0.3Ey  /  D+L + Exn-0.3Ey  /  D+L-  Exp-0.3Ey  
D+L +Eyp+0.3Ex /    D+L -Eyp+0.3Ex  /    D+L +Eyn+0.3Ex  /  D+L -Eyn+0.3Ex 
D+L +Eyp-0.3Ex  /    D+L –Eyp-0.3Ex     /    D+L +Eyn-0.3Ex   / D+L –Eyn-0.3Ex  
D+Exp+0.3Ey      /   D- Exp+0.3Ey  /    D + Exn+0.3Ey   /    D -  Exp+0.3Ey  
D +Exp-0.3Ey    /   D – Exp-0.3Ey  /    D + Exn-0.3Ey   /    D -  Exp-0.3Ey  
D +Eyp+0.3Ex    /    D -Eyp+0.3Ex     /    D +Eyn+0.3Ex     / D -Eyn+0.3Ex 
D +Eyp-0.3Ex    /    D –Eyp-0.3Ex     /    D +Eyn-0.3Ex     / D –Eyn-0.3Ex  
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Pمشخصات آناليز -2-3 − Δسازه  

در طراحي سـتون اثـر      فرض با در نظر گرفتن ضريب تشديد لنگر           به طور پيش   افزار ، نرم ETABS مطابق منوال    در طراحي به روش تنش مجاز     
الـف و ب و   -1-7-1-10اي با استفاده از روابط بند  نامه كه در روابط آيين  چرانيست؛ دوم ةنيازي به تحليل مرتب     و كند  دوم را لحاظ مي    ةمرتب

 ـ  ة دوبار  كردن نيازي به منظور    در روش تنش مجاز     بنابراين ،شود  مي دوم لحاظ    ةضرايب تشديد لنگر يكبار اثر مرتب      دلتـا در طـرح سـازه        ي اثر پ
 در   نيازي به  ،2800نامه    آيين 6-13 كه بر اين اساس با توجه به بند          شود  مي 0.1 از   كمترجدا از آن معمولاً شاخص پايداري سازه         (فلزي نيست 

  ). پس از طراحي سازه قابل كنترل استمسئله اين  دلتا نيست كه-نظر گرفتن اثر پي
تحليـل كـامپيوتري الاسـتيك غيرخطـي     (دلتا است   اثر پية دوم كه در بر گيرندةرهاي بدست آمده از مرتب   اگر در طراحي ستون از نيروها و لنگ       

-10 ةضريب تشديد لنگر براي طراحي ستون در رابط        بايد و   نيست دوم در تحليل     ة، ديگر نيازي به لحاظ مجدد اثر مرتب       شوداستفاده  ) هندسي
 .شود مي برابر يك به كار برده 1-7-1

  
  Story Drift جابجايي نسبي كنترل -2-4

 Story دو خروجي مربوط به 2-2 مطابق شكل Display > Show Tables از منوي بايدپس از آناليز سازه براي كنترل جابجايي نسبي طبقات 

Drift و Modal Participating Mass Ratio)  فت خروجي گرافزار نرمرا از ) زمان تناوب مد اول سازهجابجايي نسبي طبقات و:  

    
  خروجي مربوط به جابجايي نسبي طبقات -2-2 شكل



 با مقايسه نتايج طراحي حالت حدي و تنش مجاز ETABS افزار مثال كاربردي از نحوه طراحي حالت حدي در نرم/ بخش پنجم   606

  

  
  تعيين خروجي مربوط به تعيين جابجايي نسبي طبقات و زمان تناوب مداول سازه -3-2 شكل

-2 براي اين سازه حداكثر جابجايي نسبي طبقات در دو جهت برابر با مقادير مندرج در جدول ETABS افزار نرم Story Driftمطابق خروجي 
 :است 2

   سازه پس از آناليزStory Driftخروجي  -2-2 جدول
ETABS Story Drift 

Max Drift X 0.005777  

Max Drift Y  0.006 

 حداكثر بايد ، ثانيه بيشتر باشد0.7 چنانچه زمان تناوب سازه در مد اول از ، براي كنترل جابجايي نسبي طبقات2800طبق الزامات استاندارد  
 برابر ضريب رفتـار طراحـي سـازه         0.7مربوط به حالت غيرارتجاعي است را در مقدار         كه   را   ETABS افزار  نرمجابجايي نسبي بدست آمده از      

  . باشدتر كوچك ارتفاع طبقه 0.02از مقدار  و حاصل اين مقدار بايد كردضرب 
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-13 البته مطـابق بنـد   . دارد رانامه آيينمندرج در ز  مناسب با مقدار مجاة فاصل، براي اين سازه جابجايي نسبي طبقاتشود مي ملاحظه  البته
 مقدار دريفت در هر طبقه بايد در مركز جرم كنترل شود كه كنترل انجام شده در بالا براي مقدار ماكسيمم در هر طبقه است ،288 نامه آيين 5-4

كل جانبي در مركز جرم هر طبقه هم علاوه بر مقادير  مقدار تغييرشDisplay > Show Tablesدر منوي . كاري است  محافظهبرايكه اين كنترل 
 بـرش پايـه     شود  مي در هنگام كنترل دريفت در سازه        ،2800 نامة  آيين 4-5-13 بند   ة مطابق تبصر  كه  ايننكته ديگر   . ماكسيمم قابل مشاهده است   

  . نبوده استمسئلهعمال اين  تعيين كرد كه در اينجا نيازي به ا6-3-13زلزله را بدون توجه به محدوديت تبصره يك بند 
  
 ءپارامترهاي طراحي اعضا -2-5

  :كنيم ميبه منوي زير مراجعه  تيرهاي سازه ةپس از انتخاب هم
Design > Steel Frame Design > View/Revise Overwrite  

 :دهيم مي انجام  را تغييرات زير،شود ميباز  3-2 كه مطابق شكل اي پنجرهدر 

نظر گرفتـه    فشرده در بر اساس مقاطع براي تيرهاbF مقدار تنش مجاز بايد ، فشرده طرح شوند    بايد شي تيرها  خم هاي  قاب از آنجا كه در      -
0.6شود و از yF0.66 به مقدار yF ؛ مربع تغيير يابدمتر سانتيكيلوگرم بر  1584 يعني مقدار  

 Unbraced Lengthة در گزين،شوند و امكان كمانش جانبي پيچشي ندارند ها و دال بتني مهار مي  تيرهاي سقف توسط تيرچهكه اين بدليل -

Ratio (minor.LTB) هاي جانبي بـال فـشاري    گاه  بين تكيهة فاصلةواقع اين ضريب به منزل در .كنيم ميمنظور ) 0.01 معمولاً( مقداري كوچك
  .تير است
  :كنيم مي به منوي زير مراجعه  سازهيها ستون ةتخاب همپس از ان

Design > Steel Frame Design > View/Revise Overwrite  
  :دهيم مي تغييرات زير را انجام شود، مي باز 4-2 كه مطابق شكل اي پنجرهدر 

ETABS ضرايب K و  Moment Coefficient (Cm)نـشده   ازه در هر دو جهت قاب مهار سكه اين بر اساس فرض پيش را به طور ها ستون
بـراي آن صـحيح   0.85  ضـريب  ، اگر قاب مهار نشده باشـد .كند ميتعريف  0.85 فرض پيش را برابر مقدار Cm و مقدار كند مياست، محاسبه 

 . خواهد بودكارانه محافظهاگر قاب مهار شده باشد اين ضريب براي آن  اما ؛است و نيازي به ويرايش آن نيست

 مبحـث   1-1-7-2-10يا بنـد     (2800 نامة  آيين 2 پيوست   3-5 قاب خمشي فاقد بادبند يا ديوار برشي با رعايت شرايط بند             هاي  زهسابراي  
 شرط اين است كه شاخص پايـداري  ترين مهم سازه را مهاربندي شده فرض كرد، براي اين منظور       توان  مي ،)دهم در مورد روش حالات حدي     
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. شود  مي خمشي عملاً رعايت     هاي  قاب ولي معمولاً در     ، قبل از طراحي سازه قابل كنترل نيست       مسئلهاين  .  شود 0.04 از   كمترسازه در هر طبقه     
در . ( كه آيا اين فرض صحيح است يـا خيـر          كنيم  مي و پس از طراحي كنترل       دهيم  مي در ابتدا فرض را بر مهارشدگي سازه قرار          علتبه همين   

  .)ين فرض كنترل شده است صحت ا3-3فصل سوم اين بخش در جدول 

 
  ETABS در تغيير مشخصات طراحي تيرهانحوه مشاهده و    -4-2 شكل

  مهـار شـده   قاب را از نوعFrame Type در قسمت ، 3-2 نمايش داده شده در شكل  و اجراي منويها ستونبا انتخاب بر اين اساس بايد 
Braced Frame انتخاب كنيم تا ضريب Cm مهار شده محاسبه شود و همچنين ضرايب هاي قاب مطابق با روابط K براي هر دو جهت Major 

  . ويرايش شود1 برابر عدد Minorو 
 فشرده در بر اساس مقطع     ها  ستونبراي  حول محور قوي     bF مقدار تنش مجاز   بايد ،هاي سازه حول محور قوي      فشرده بودن ستون   علتبه  

0.6نظر گرفته شود و از yF0.66 به مقدار yF مربع تغيير يابدمتر سانتيكيلوگرم بر  1584 يعني .  
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  ETABS در ها ستونصات طراحي  مشاهده و تغيير مشخةنحو   -5-2 شكل

  
 مقاطع نهايي طرح شده در روش تنش مجاز -2-6

Design > Steel Frame Design > Make AutoSelct Null 
 كـردن اتوسـلكت از   غيرفعال اعضاي سازه و سپس ةانتخاب هم، با Auto Select از روي ها ستونپس از طرح اوليه به وسيله انتخاب تيرها و 

آيد تا نتايج حاصل از نسبت تنش مقاطع، با طرح همين سازه با همـين   روش تنش مجاز بدست ميه  طع نهايي طرح شده ب    طريق منوي بالا، مقا   
  .شودروش حالت حدي مقايسه ه مقاطع ب

  .ها بين دو حالت حدي و تنش مجاز آورده خواهد شد  نسبت تنشةهمراه با مقايساين بخش  فصل چهارمنتايج نهايي در 
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  طراحي به روش تنش مجازگرافيكي نتايج  -2-7
آورده شـده اسـت، همچنـين        5-2 در اشـكال     4 و   1 ةقـاب شـمار    و    و پنجم   اول ةروش تنش مجاز در طبق    ه  چند نمونه از مقاطع طرح شده ب      
  : آورده شده است3-2 در جدول ءمشخصات نهايي مقاطع اعضا
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  4 و 1قاب  اول و ة طبقرروش تنش مجاز ده چند نمونه از مقاطع طرح شده ب -6-2 شكل
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سـازه را   مشخصات مـصالح و وزن  Display > Show Table > Building Data > Material Listپس از طراحي سازه با انتخاب خروجي 

  .كرد مشاهده توان مي 4-2 و 3-2مطابق جداول 

  مشخصات نهايي اعضاي طرح شده به روش تنش مجاز -3-2 جدول
Section ElementType 

IPE160 Beam 

IPE180 Beam 

IPE200 Beam 

IPE220 Beam 

IPE240 Beam 

IPE270 Beam 

IPE300 Beam 

IPE270_2PLF200X5 Beam 
IPE300_2PLF250X5 Beam 

2IPE22 Column 

2IPE24 Column 

2IPE27 Column 

2IPE30 Column 

2IPE240_2PLF280X20_D200 Column 

2IPE270_2PLF400X25_D290 Column 

  

  )متر -تن ( مصالح فولادي طرح شده در روش تنش مجازمشخصات -4-2 جدول

Story ElementType Material TotalWeight FloorArea UnitWeight NumPieces 

SUM Column STEEL 84.986 2346.5 0.0362 184 

SUM Beam STEEL 55.631 2346.5 0.0237 304 

TOTAL All All 140.617 2346.5 0.0599 488 

  
 .است تن  140.617 وزن كل مصالح فولادي طرح شده به روش تنش مجاز 4-2مطابق جدول 



  
  
  

  فصل سوم
  LRFDروش حالت حدي ه هاي طراحي سازه بپارامتر

  
  
  
  
  
 AISC 360-05/IBC2006 طراحي ةنام  آيينتنظيمات -3-1

  :كرد مراجعه  زير بخش بهبايد ،ETABS در AISC360−05 ةنام آيين و تغيير پارامترهاي طراحي بر مبناي براي معرفي
Options/Preferences/Steel frame design  

  :هستند نيازمند تغيير 1-3شكل از  موارد زير
  ؛دهيم ميتغيير  AISC360−05 موردنظر ةنام نامه را به آيين  آيين نوعابتدا -
  كنيم؛ انتخاب مي يعني قاب خمشي متوسط ،IMF نوع قاب را Frame Type در قسمت -
اي  نياز بـه لحـاظ ضـوابط طـرح لـرزه       عدمبراي از بخش چهارم 5-1حات قسمت ي با توجه به توضSeismic Design Category در قسمت -

  ؛كنيم انتخاب ميرا  A ةناحي
، در بخش چهارم توضيحات مربوطه آورده شده است كه با توجه بـه  Importance Factor ،System Rho ،System Sdsهاي  در مورد قسمت-

  ؛ريمپذي فرض را مي نياز به تغيير اين پارامترها براي طرح اين پروژه مقادير پيش  عدم
- System R ةنام ازآنجا كه در آيين. است معرف ضريب رفتار سازه در حالت حدي AISC،عدم لحاظ ضوابط طـرح  براي ، ضريب رفتار پايه 

 ضـريب بـار زلزلـه در حالـت     ةلازم به ذكر است به دليل اعمال جداگان(شود  مي جايگزين 3 بنابراين در اين قسمت نيز    است، 3اي مقدار    لرزه
اي از ايـن پـارامتر اسـتفاده          عـدم طراحـي لـرزه      علـت  چراكه در طول طراحـي بـه         ،نامه نيست   فرض آيين   به تغيير مقدار پيش     هم زيحدي نيا 

  ؛)شود نمي
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  يروش حالت حده  مشاهده و اعمال تغيير در ضرايب كاهش مقاومت طراحي بةنحو -1-3 شكل

- System Cd ايـن  ،2800 ةنام ـ  و مطـابق آيـين  كنـد  مـي  نهايي تبديل تغييرشكلكه تغييرشكل الاستيك را به  است تغييرشكل ضريب افزايش 
0.7ضـــريب در طراحـــي بـــه روش تـــنش مجـــاز برابـــر wR 0.7و در طراحـــي در حالـــت حـــدي نهـــايي برابـــر uR اين بنـــابر .اســـت

5.357.07.0مقدار =×=uR  بـا مهاربنـد      هاي  قابالبته اين پارامتر فقط در طراحي        (شود فرض مي  جايگزين مقدار پيش EBF    داراي كـاربرد 
  ؛)شود نمي خاصي از آن ة استفاد،افزار نرم فعلاً در ها سيستم ةاست و در بقي

  ؛كنيم مي انتخاب LRFD ةين، روش طراحي اعضاي فولادي را گزDesign Provision ة در جعب-
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 Ignor Seismic Code و Ignor Special Seismic Loads ةاي در اين پروژه دو گزين  به لحاظ الزامات طرح لرزهنياز  عدم علت و در آخر به -

 قرارگيري ة و ناحي3ر  قبلي ضريب رفتار را برابهاي قسمتالبته چون در  ( دهيم  تغيير ميYesبه  را است Noفرض آنها  كه مقادير پيشرا 
 عدم اعمال براي ،بين اين دو مورد اگر يكي اعمال شود.  در اينجا نيستمسئله اين ةبه اعمال دوبار لزومي ،ايم كرده انتخاب A ةسازه را ناحي

  .)كند ميضوابط طرح لرزه اي كفايت 
 بـا مقـادير     ،فرض در برنامـه وجـود دارد        به صورت پيش   اين ضرايب كه  .  قابل ويرايش است    نيز  مقادير ضرايب كاهش مقاومت    ،پنجرهدر اين   

  .مورد نظر مبحث دهم انطباق داشته و نيازي به ويرايش ندارند
  
  ETABS در  حالت حدي دومة مرتبآثار -3-2

مطابق  است كه دوم ة مربوط به لحاظ اثر مرتبSecond Order Method و Design Analisis Methodهاي  گزينه 1- 3در شكل 
  . دوم وجود داردة مختلف براي لحاظ اثر مرتبهاي روش AISC 360-05 ةنام آييندر  نمودار زير

ETABS jf ßga OÈCa ÉÓf ØHQkÌ kUB ÅCË®B ×Ô`Ð

Design Analysis Method

Second Order Method

Êá»PrÌ máÈCÐD

kUÔÌ ÅÔ¥

ÅÓB ØHQkÌ

ÉÓf ØHQkÌ àÌÔË® máÈCÐD

ØP¸Câ gâgvQ ÅÓB ØHQkÌ  
ر  لحـاظ كـردن ايـن آثـا        ةدر اين بند نحـو    .  دوم است  ة با لحاظ كردن آثار مرتب     ء مربوط به طراحي اعضا    5-1-7-2-10بند  در مبحث دهم    

عمـومي تحليـل غيرخطـي هندسـي و ضـرايب       از دو روش بايد ، دومة لحاظ اثر مرتببراي به طور كلي مطابق اين بند . توضيح داده شده است   
  درETABS تنظيمات هر كدام از دو روش فـوق در    . يك روش انتخاب و اعمال شود      ،)4-1-7-2-10 و   3-1-7-2-10بندهاي  (تشديد لنگر   

  .دشو ميادامه توضيح داده 
 Effective Length يـا  مـؤثر  روش طـول  ، دوم در حالت حدية لحاظ مرتبهاي روش مطابق توضيحات بخش چهارم از بين انواع بنابراين

  .است موارد زير ETABS دوم در ة لحاظ آثار مرتببرايهاي موجود   لذا گزينه؛مطابقت بيشتري با مبحث دهم دارد
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ETABS jf ßga OÈCa ÉÓf ØHQkÌ kUB ÅCË®B ×Ô`Ð

Design Analysis Method

Second Order Method

kUÔÌ ÅÔ¥

ÉÓf ØHQkÌ àÌÔË® máÈCÐD

ØP¸Câ gâgvQ ÅÓB ØHQkÌ  
  
   دوم با استفاده از روش عمومي تحليل غيرخطي هندسيةآثار مرتب -3-2-1

Pيكـي اثـر ثانويـه بـراي بارهـاي جـانبي       .اسـت  تحليل غيرخطي هندسي نيازمند انجام دو نوع تحليل سازه   ةلحاظ كردن اثرهاي ثانوي    − Δ و 
Pهاي ثقليديگري اثر ثانويه براي بار δ−. 

 بايــــد در منــــوي ،ETABSدر ) تحليــــل غيرخطــــي هندســــي (3-1-7-2-10 از روش بنــــد در صــــورت انتخــــاب اســــتفاده
Options/Preferences/Steel frame design ة در گزين2-3 مطابق شكل Design Analisis Method،ة گزين ـ Effective Length  و بـراي 

Second Order Method،ة گزين General 2nd Orderرا انتخاب كنيم . 

  
   دوم به روش عمومي تحليل غيرخطي هندسيةتنظيم لحاظ اثر مرتب -2-3 شكل

P تحليل • − Δ در ETABS:  
P تحليلة گزين3-3 مانند شكل ، باز شدهةدر جعب .كنيم را مي را اجAnalyze > Set Analysis Optionدستور  − Δ بـراي  .كنيم را فعال مي 

Pتحليل − Δ برداري بهره  در حالت از تركيب بار2800 ةنام آيينبر اساس ضوابط   ، بايدLD  روش طراحـي   ربطي بهمسئلهاين  (شوداستفاده +
البته در اين مورد اختلاف نظرهايي هـم وجـود          .  بايد از همين تركيب بار استفاده شود       ، حدي و تنش مجاز    هاي  حالتندارد و در هر دو روش       

، آنچـه  ن در ايـن زمينـه  سايت مركز تحقيقات ساختمان و مـسك وب هاي موجود در   و پرسش و پاسخ2800 نامه آيين ولي بر اساس متن  ،دارد
 بنـابراين تركيـب     ؛)برداري اسـت    است ، صرفنظر از درستي يا نادرستي آن، استفاده از تركيب بار بهره             2800 نامه  آيينكنندگان   د نظر تدوين  مور
  .شود ميتركيب بار استفاده همين از نيز ها و جابجايي نسبي  تغييرشكلبراي كنترل .شود مي انتخاب  D+Lبار
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Pنظر گرفتن تحليل  درةنحو -3-3 شكل − Δ درETABS  

Pتحليل • δ− درETABS:  
 ،باشـند معلوم ) در طول ستون( انتهايي ةهاي بين دو گر تغييرشكل مربوط به بارهاي ثقلي لازم است كه      ةاز آنجا كه براي انجام تحليل ثانوي      

بنـدي   لازم است ستون در طول خود تقسيم ،كند ميها محاسبه  در محل گرهتنها ها را   جابجاييETABS ة برنام كه  اينبدين منظور و با توجه به       
  . شوند
 هـاي   المـان حـل مناسـب بـراي تقـسيم سـتون بـه              راه ، از بخش چهارم در اين رابطه توضيح داده شده است          3-3 كه در قسمت     طور  Ĥنهم

 و برنامـه بـه طـور داخلـي ايـن            شـود   نمـي  تقـسيم    سـازي   مدلدر اين حالت ستون در       . خودكار برنامه است   بندي  تقسيم استفاده از    ،تر  چككو
در ايـن روش     . و طول آزاد كمانش به وجود نخواهد آمد        مؤثر روش مشكلات مربوط به ضريب طول         و با اين    را انجام خواهد داد    بندي  تقسيم

 اجـزاي محـدود     بنـدي   تقسيم بايدسپس   .هايي ايجاد كند    گره  و  شود بندي  تقسيم ستون   ،داند  ميهايي كه لازم     دا در موقعيت  لازم است كاربر ابت   
  .شودي مياني فعال ها گره در محل ها ستونبراي 

 Snap toعلامـت  براي اين منظـور بـا انتخـاب     .شود مي استفاده Draw > Draw Point Objectsبراي ايجاد گره در طول ستون از دستور 

Lines and Edges . از منويDraw > Snap to قـرار دادن دو گـره در   معمـولاً .  تعريف نمودتوان ميي بين دو سر ستون در هر طبقه را ها گره 
  .استطول ستون كافي 
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 < Assignر مـسير   اجـزاي محـدود خودكـار كـه د    بنـدي  تقـسيم  انتخاب شوند و دستور ها ستون در طول ستون بايد ها گرهپس از ايجاد 

Frame/Line > Automatic Frame Subdivideةدر اين جعبه با انتخاب گزين . اجرا شود، است Auto Mesh at intermediate points  ها ستون 
ه نشان هاي ترسيم شده روي يكي از نماهاي ساز گره 4-3در شكل  .شوند مي بندي تقسيمي موجود در طول آنها به طور داخلي  ها  گرهدر محل   

  .داده شده است

 
  )طبقه هر ستون در ميتقس سه( گره 2 با خود طول در ها ستوني بند ميتقس -4-3 شكل

 با طول بلند و هاي ستون و تنها براي   هستند ناچيز Δ−Pدر اكثر موارد نسبت به     δ−P ثقلي بارهاي تشديد لنگر مربوط به      ةاثرات ثانوي 
  .مقطع كوچك بحراني خواهد شد

  
   دوم با استفاده از روش تشديد لنگرهاي خمشيةآثار مرتب -3-2-2

ل  مطابق شـك Options/Preferences./Steel Frame Design اعمال شود بايد در منوي 4-1-7-2-10 بند ة اين آثار بر اساس ضابطكه آنبراي 
 انتخـاب  Amplified 1st Order ة گزين،Second Order Method و براي Effective Length ة گزين،Design Analysis Method ة در گزين3-5

  .كنيم

  
   دوم به روش تشديد لنگرهاي خمشيةتنظيم لحاظ اثر مرتب -5-3 شكل
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 ـبا كتـاب  چهـارم  بخش حاتيتوض مطابق ،ETABS افزار  نرم در 4-1-7-2-10 بند ضوابط از استفاده با لنگر ديتشد وشر مورد در  بـه  دي
  :شود توجه ريز نكات
Pبا فرض انجام تحليلنيست و اين ضريب را  B2  ضريبة قادر به محاسبافزار نرم − Δ   يـك  فـرض برابـر    طـور پـيش  بارهاي جـانبي بـه 

اي دارد و    كننده  نقش تعيين  ، مهار نشده  هاي  قاباين ضريب در مورد     . توان مقدار آن را به طور جداگانه وارد كرد         گيرد كه براي هر عضو مي      مي
  .ها بايد مقدار آن حتماً وارد شود ب براي اين قا

فـرض برنامـه     كـه پـيش   B2 قبول عدد يك براي ضريببنابراين با توجه به اين توضيحات، در اين پروژه با فرض مهار بودن هر طبقه و با
 طبقه مهار   ( بيشتر باشد    0.05چنانچه شاخص پايداري طبقات از        سپس با كنترل شاخص پايداري هر طبقه،       ،دهيم  محاسبات را انجام مي    ،است

ه در دو جهـت اصـلي بـه صـورت     محاسبه و براي تمامي اجـزاي طبق ـ  B2  جداگانه به صورت دستي ضريب، براي هر طبقهبايد ،)نشده باشد
 باشـد  0.05 از كمتـر  اما اگـر شـاخص پايـداري       .شود  مي دهم محاسبه    مبحث 7-7-2-10 ةابطمطابق ر  B2مقدار ضريب   . شودجداگانه اعمال   

ده يـا   بنابراين كنتـرل مهـار ش ـ      .استقابل قبول     مبحث دهم،  7-2-10 نسبت به ضوابط فصل      ي، طرح با انطباق خوب    )طبقات مهار شده باشند   (
  .استترين قسمت  نشده بودن طبقات در اين روش اصلي

  
   مبحث دهم1-1-7-2-10 مهار شده مطابق بند ةكنترل طبق -2-2-1- 3

چنانچه شاخص پايداري طبقه كه نسبت لنگـر ثـانوي بـه             شود كه تغييرمكان جانبي نسبي آن ناچيز باشد،        اي اطلاق مي    مهار شده به طبقه    ةطبق
در اين حالت تمام قطعات  .شود  جانبي تلقي ميةشد  باشد، طبقه مهار0.05 از تر كوچك ،شود مي تعيين 1-7-2-10 ة و از رابطاستلنگر اوليه 

  .شوند  مهارشده ناميده مي اصطلاحاً،فشاري واقع در اين طبقه

)رابطه  )10-2-7-1( ) H
i

P

HL
θ ∑ Δ

=  
 :در اين رابطه

P=    اولةهاي يك طبقه بر پايه تحليل مرتب ستون) دار ضريب( محوري نهاييمجموع نيروهاي  ∑
H= Δزيرين، متناظر با نيروهاي فوقة تغييرمكان جانبي طبقه نسبت به طبق   
L= ارتفاع طبقه  

H= كـه پـس از آنـاليز سـازه از خروجـي       استطبقه ) دار ضريب( نيروي برشي نهاييFile > Print Tabels > Analysis Output > Frame 

Output > Column Forces مقادير حداكثر بار محوريPو برش ضريب دار  V تحت بيشتر تركيب بار، براي طبقات ST1 تا ST5  براي بـالا و 
 :شود  استخراج مي1-3 مطابق جدول ،پايين طبقه
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 ETABS حاصل از آناليز سازه در ةطبق) دار ضريب( وي برشي نهاييرين -1-3جدول 

S T O R Y   F O R C E   E N V E L O P E S  
ETABS v9.6.0      File:MOMENT STEEL      Units:Ton-m   

  
   ITEM                   P              VX              VY               T              MX           MY 

 ST-5        Top  
                         Max Value         552.65           138.92           138.92         2237.899       5358.260   -3575.518 
                         Max Case           COMB8      COMB31      COMB35      COMB36       COMB7      COMB34 

 ST-5        Bottom  
                         Max Value         561.29          138.92           138.92       2237.899    5445.409   -3229.265 

                         Max Case           COMB8      COMB31      COMB35      COMB36       COMB7      COMB34 
   

 ST-4        Top  
                         Max Value        1140.29         257.27          257.27         4144.385      11059.910   -6780.182 

                         Max Case           COMB8      COMB31      COMB35      COMB36       COMB7      COMB31 
 ST-4        Bottom    

                         Max Value        1155.48          257.27          257.27         4144.385     11214.209   -6132.303 
                         Max Case           COMB8      COMB31      COMB35      COMB36       COMB7      COMB31 

   
 ST-3        Top  

                         Max Value        1737.07          347.36           347.36         5595.647      16854.964   -9704.307 
                         Max Case           COMB8      COMB31      COMB35      COMB36       COMB7      COMB31 

 ST-3        Bottom 
                         Max Value        1763.70         347.36           347.36         5595.647       17123.745   -8879.515 
                         Max Case           COMB8      COMB31      COMB35      COMB36       COMB7      COMB31 

   
 ST-2        Top  

                         Max Value        2346.59          407.23          407.23        6560.146      22776.787   -12462.184 
                         Max Case           COMB8      COMB31      COMB35      COMB36       COMB7      COMB31 

  ST-2        Bottom  
                         Max Value        2373.22          407.23          407.23         6560.146        23049.226  -11457.777 

                         Max Case           COMB8      COMB31      COMB35      COMB36       COMB7      COMB31 
   

 ST-1        Top          
                         Max Value        2943.88          434.84          434.84         7004.918      28582.433  -14940.656 
                         Max Case           COMB8      COMB31      COMB35      COMB36       COMB7      COMB31 

     ST-1        Bottom   
                         Max Value        2968.37          434.84          434.84         7004.918       28838.977  -13966.425 
                         Max Case           COMB8      COMB31      COMB35      COMB36       COMB7      COMB31  

  :توجه شود
 ،استبا يكديگر يكسان  xو  y  مقدار برش در جهت، برابر بودن سختي سازه در دو طرف و نيز بارگذاري متقارندليل به •

مـا   ا ،اسـت  براي بالا و پايين طبقـه يكـسان           اين مقدار   طبقات براي بالا و پايين هر طبقه جداگانه آورده شده است كه            ةمقادير برش پاي   •
 اطمينان مقدار نيروي محوري بيشتر كه مربـوط بـه     براي براي بالا و پايين طبقه اندكي متفاوت است كه           مقدار آن  ،براي نيروي محوري  

  .شود استحراج مي ،استپايين طبقه 
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H= Δ  دار آن از خروجي كه مق است  زيرين، متناظر با نيروهاي فوقةطبقه نسبت به طبقهرتغييرمكان جانبيStory Drift  مربوط به هر طبقـه 

  :آيد  بدست مي2-3از جدول 
  ETABSدر حاصل از آناليز سازه   نسبت به طبقه زيرينةتغييرمكان جانبي هر طبق -2-3جدول 

 S T O R Y   D R I F T   E N V E L O P E S 
ETABS v9.6.0  File:MOMENT STEEL  Units:Ton-m  July 28, 2010 13:56  PAGE 4 

 LOAD   /    POINT         /        X           Y           Z     /     MAX DRIFT                                
  ST-5        X           COMB27          36                24.000      19.400      14.700    0.006649 
 ST-5        Y           COMB20          36                24.000      19.400      14.700    0.005995 

   
 ST-4        X           COMB27          36                24.000      19.400      11.700    0.007060 
 ST-4        Y           COMB18          36                24.000      19.400      11.700    0.005982 

   
 ST-3        X           COMB29          31                24.000       0.000       8.700    0.006755 
 ST-3        Y           COMB33          36                24.000      19.400       8.700    0.005599 

   
 ST-2        X           COMB25          36                24.000      19.400       5.700    0.006640 
 ST-2        Y           COMB18          36                24.000      19.400       5.700    0.005228 

   
 ST-1        X           COMB31          31                24.000       0.000       2.700    0.003772 
 ST-1        Y           COMB17          36                24.000      19.400       2.700    0.002683  

  .است ارتفاع طبقه =Lو
 : داريم،ه تنظيم گرديدExcelكه در فايل  3-3  مطابق جدول،بنابراين براي شاخص پايداري هر طبقه

  :كنيم  بررسي مي3-3 شاخص پايداري براي كنترل مهار شده بودن اين طبقه را مطابق جدول ، مبحث دهم1-7-2-10 ةطبق رابط
( )

0.05 ?H
i

P

HL
θ ∑ Δ

= < →  

  كنترل شاخص پايداري در هر طبقه -3-3جدول 

HΔ به متر  
 05.0<iθ  ( )

0.05H
i

P

HL
θ ∑ Δ= <  

y x y x 

L 
y x 

H P∑  
 

 شماره طبقه

OK OK 0.00807 0.00895 3 0.005995 0.006649 138.92 561.29 پنجم 

OK OK 0.00895 0.01056 3 0.005982 0.00706 257.27 1155.48 چهارم 

OK OK 0.0094 0.01143 3 0.005599 0.006755 347.36 1763.7 سوم 

OK OK 0.01015 0.01289 3 0.005228 0.00664 407.23 2373.22 دوم 

OK OK 0.00678 0.00953 2.7 0.002683 0.003772 434.84 2968.37 اول 
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  .و بايد در طراحي آن تجديدنظر كرد  ناپايدار محسوب شده، موردنظرة بيشتر باشد، سازه در طبقmaxθدر صورتي كه شاخص پايداري طبقه از

max 0.25θ =  
  . ناپايداري رخ نخواهد داد3-3دول جكه در اين سازه طبق نتايج 

 طبقات در قاب خمشي اين پروژه از نـوع مهـار        ةو كلي  است برقرار   0.05 از   تر  كوچك شرط شاخص پايداري طبقه      3-3دول  جطبق نتايج   
  .است دوم با دقت خوبي منطبق بر روابط مبحث دهم بوده و قابل قبول ة در اثر مرتبB2رفته شده براي تغييرات  و فرضيات پذياستشده 
Pة گزينكردنست در صورت استفاده از اين روش احتياجي به فعال ي ابديه − Δ در منوي Analyze > Set Analysis Option نيست.  

 در  B2 به خـصوص محاسـبه نـشدن مقـدار ضـريب             ، اول وجود ندارد   ة فرضياتي كه در استفاده از روش تشديد مرتب        علتبه  
ETABS   دوم ةرسد كه در حال حاضر بهترين روش استفاده از روش عمومي تحليل مرتب              به نظر مي P − Δ  كـه در ايـن      اسـت 

  .شود مييسه استفاده  مقابرايپروژه از نتايج اين روش تحليل 

  
   نهايياعمال ضريب زلزله براي حالت حدي -3-3

 لحـاظ نيروهـاي زلزلـه در    علت به ،آمده استدر حالت حدي در ادامه توضيحات مربوط به تعريف بار زلزله كه در فصل اول از همين بخش  
ا كه در تركيبات بار مبحـث دهـم         اما از آنج   ،) بخش چهارم كتاب   3-1قسمت  ( كرده ضرب   1.4 مقادير ضريب زلزله را در       ،حالت حدي نهايي  

 و با ضريب برداري بهره در حالت AISC 360-05 ةنام آيين بارهايكه تركيب   در صورتي،اند  آمده1.2حالت نهايي و با ضريب در ارهاي زلزله ب
 ضريب رفتار و به عبارتي بيـشتر        ةبار بنابراين با انتخاب تركيبات بار مندرج در مبحث دهم از ضرب دو            ؛) بخش چهارم  3-1قسمت   (هستند 1

  .شود ميدر حالت حدي نهايي صرفنظر درنظر گرفتن بار زلزله 
 بـه روش حـدي و   هـا  سـازه  اما تعريف نشدن ضريب رفتـار طـرح   ،خيلي منطبق با واقعيت باشدبه طور كامل     تواند  نمياگرچه اين روش    

 تـا بـراي   ، باعـث شـده اسـت   AISC 360-05رج در مبحث دهم با تركيبـات بـار   همچنين متفاوت بودن ضرايب بار زلزله در تركيبات بار مند
جلوگيري از طرح غيراقتصادي سازه از ضرب ضريب رفتار سازه صرفنظر شود و براي طرح سازه در حالت حدي نهايي از همان ضريب رفتار 

  . استفاده شود،سازه كه در روش تنش مجاز بدست آمده است
  
  Notional Loads مجازيتعريف بارهاي  - ۴- ٣

 0.2 مجازي به ميـزان      ي در تركيبات بار، بار    بايد ، تحليل غيرخطي هندسي و ضرايب تشديد لنگر       ، براي هر دو روش عمومي     5-1-7-2-10طبق بند   



  LRFD  629روش حالت حدي  هپارامترهاي طراحي سازه ب/ فصل سوم 
  . به منظور لحاظ اثرات خطاهاي اجرايي در حين كار اعمال شود، همزمان با بارهاي ثقلي در تراز طبقات،دار درصد بارهاي ثقلي ضريب

  
 Load Cases در مجازينكات تعريف بارهاي  -3-4-1

 ؛شوند ميتعريف  Notional  از نوعمجازيبارهاي  •

  Notionalدو حالـت بـار   يعني به ازاي هر حالت بـار ثقلـي،  . خواهيم داشت مجازي هاي بار ثقلي، حالت بار از نوع  به تعداد دو برابر حالت •
 ؛است y  اعمال بار جانبي در جهتبرايو ديگري  x ي در جهت اصلييكي از اين دو حالت براي بار جانب. شود ميتعريف 

 : عمل كرد،هستتر نيز  تر و منطقي توان به روش زير كه راحت به سازه مي Notional براي اعمال بار  •

 جديـدي  ة تـا صـفح  كنيـد كليك  Modify Lateral Load  و سپس بر روي دكمهكردهانتخاب   Auto Lateral Load در ستون Auto ةگزين
حالت بار ثقلي متنـاظر بـا   ،  Base Load Caseدر اين صفحه در قسمت. شود مي در آن تنظيمات لازم انجام  كهشودمطابق شكل زير ظاهر 

 و يا هر عدد دلخواه مورد نظر ديگـر  )2 قسمت 5-1-7-2-10 بند ةمطابق ضابط (0.002عدد  Load Ratio در قسمت .شود ميآن انتخاب 
 اعمـال بـار از بـين دو    بـراي نيـز   Notional Load Direction در قسمت .)فرض در برنامه وجود دارد ين عدد به طور پيشا(شود  وارد مي

 .شود ميانتخاب  Global Y و  Global X ةگزين

  :عنيي. شوند مي مقدار در دو راستا، براي بارهاي مرده و زنده تعريف 0.002 برابر 6-3مطابق شكل  Notional Load مجازيبار 
Nlive y و  Nlive x و  Ndead yو  Ndead x  

 
  ETABSدر مجازي  بارهاي نظر گرفتن در ةنحو -6-3 شكل
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 Load Combination در مجازيشاركت بارهاي منكات  -3-4-2

  :دهيم ميهاي بار را مشاركت  نيز اين حالت Define/Load Combinations در قسمت Notional هاي بار پس از تعريف حالت
 ؛شوند كه فقط شامل بارهاي ثقلي هستند تنها در تركيب بارهايي مشاركت داده مي Notional هاي بار حالت •

 ؛ در همان تركيب بار است،برابر ضريب بار ثقلي متناظر با آن Notional  بارهاي حالتضريب بار براي هر كدام از  •

اگر در يك حالت تمام آنها با ضـريب مثبـت تركيـب     .بايد با يك علامت با هم تركيب شوند Notional يب بار تمام بارهايدر هر ترك •
 ؛باشندبه طور همزمان داراي ضريب منفي  Notional ، به طور متناظر بايد تركيب بار ديگري ساخته شود كه در آن تمام بارهاياند شده

. باشند y) اي  x( هدهيم كه مربوط به يك جهت اصلي ساز ي را مشاركت ميهاي حالتمربوط به  Notional در هر تركيب بار تنها بارهاي •
بـر ايـن   . شوند مشاركت داده ، باري كه براي جهت اصلي ديگر هستندهاي حالتسازيم كه در آن  به طور متناظر تركيب بار ديگري مي      

 ،) مبحث دهـم 2-1-2-10مطابق جدول ( تنها شامل دو تركيب بار است ، ثقلي در حالت عادي تركيب بارهايكه ايناساس با توجه به  
  . عدد خواهد رسيد8 برابر شده و به 4در حالت اعمال اين بارها، تعداد تركيبات 

 
  روش حالت حدي طبق مبحث دهمه  بار طراحي باتتركيب -3-5

 .ذكـر شـده اسـت    3-1-2-10و  2-1-2-10 جـداول ت و -4-3-1-2-10دهم در بند  حدي در مبحث هاي حالتتركيبات بارگذاري روش 
  : به شرح زير است،تري دارند برخي از تركيب بارهايي كه مربوط به جدول اول بوده و حالت عمومي

1.4D   
1.25D+1.5L   
D+1.2L+1.2(E or W )  
0.85D+1.2(E or W )   

جـايگزين مقـادير     بايـد تركيبـات بـالا را         علـت به همـين     و اندكي متفاوت هستند     ،فرض برنامه  تركيب بارهاي بالا با تركيب بارهاي پيش      
  .شود درصد جهت مقابل تركيب 30 درصد نيروي زلزله در هر جهت با 100بايد  و كنيمفرض برنامه  پيش

 8اما با ضـرايب متفـاوت نيـاز داريـم كـه بـا       ) تنش مجاز  تركيب بارD)−34 و (D+L( تركيب بار 32بنابراين مطابق حالت تنش مجاز به 
  .است طراحي نياز براي 4-3 تركيب بار مطابق جدول 40 به  جمعاً،تركيب بار اضافي مربوط به بارهاي ثقلي مجازي

  LRFDتركيبات بار در روش حالت حدي  -1-3 جدول
1.4Dead+1.4NDeadx   ,   1.4Dead-1.4NDeadx       
1.4Dead+1.4NDeady   ,   1.4Dead-1.4NDeady       

 
1.25Dead +1.5Live+1.25NDeadx +1.5NLivex 
1.25Dead +1.5Live-1.25NDeadx -1.5NLivex 
1.25Dead +1.5Live+1.25NDeady +1.5NLivey 
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1.25Dead +1.5Live-1.25NDeady -1.5NLivey 

 
D+1.2L +1.2Exp+0.36Ey  /   D+1.2L - 1.2Exp+0.36Ey  /  
D+1.2L +1.2Exp-0.36Ey  /  D+1.2L – 1.2Exp-0.36Ey  /  

 
D+1.2L + 1.2Exn+0.36Ey /  D+1.2L-1.2Exp+0.36Ey 
D+1.2L + 1.2Exn-0.36Ey  /  D+1.2L- 1.2Exp-0.36Ey 

  
D+1.2L +1.2Eyp+0.36Ex /    D+1.2L -1.2Eyp+0.36Ex  / 
D+1.2L +1.2Eyp-0.36Ex  /    D+1.2L –1.2Eyp-0.36Ex  / 

 
D+1.2L +1.2Eyn+0.36Ex  /  D+1.2L -1.2Eyn+0.36Ex    
D+1.2L +1.2Eyn-0.36Ex   / D+1.2L –1.2Eyn-0.36Ex 

  
0.85D+1.2Exp+0.36Ey      /   0.85D- 1.2Exp+0.36Ey  /  
0.85D +1.2Exp-0.36Ey    /   0.85D – 1.2Exp-0.36Ey  /  

 
0.85D + 1.2Exn+0.36Ey   /    0.85D -  1.2Exp+0.36Ey  
0.85D + 1.2Exn-0.36Ey   /    0.85D -  1.2Exp-0.36Ey 

  
0.85D +1.2Eyp+0.36Ex    /    0.85D -1.2Eyp+0.36Ex     / 
0.85D +1.2Eyp-0.36Ex    /    0.85D –1.2Eyp-0.36Ex     / 

 
0.85D +1.2Eyn+0.36Ex     /       0.85D -1.2Eyn+0.36Ex  
0.85D +1.2Eyn-0.36Ex     /    0.85D –1.2Eyn-0.36Ex 

  
  ETABS مشكل طراحي حالت حدي براي مقاطع تعريف شده در -3-6

از لحاظ برنامه به صورت غيرفشرده  SECTION DESIGNER ا مقاطع ساخته شده باي GENERAL  به صورتافزار نرممقاطع معرفي شده به 
در  . نـشان داده خواهـد شـد       ، طراحـي پيغـام عـدم فـشرده بـودن مقطـع            ،بنابراين پس از انجام طراحي در قسمت جزئيـات         ،شوند  ميشناخته  

گيرد و كنترل اين مقاطع براي اين الزامات بايـد    اين الزامات انجام نمي، داشته باشيم3-10اي  د كنترل ضوابط طرح لرزه چنانچه قص صورت  اين
  .شودبه صورت دستي انجام 

  آنهـا در   اساس مقطـع الاسـتيك     ، قرار گيرد  يار طراح ي مع ،كي پلاست اساس مقطع  كه  آن ياج  به  براي خمش  ءعلاوه بر آن در طراحي اعضا     
لام نـسبت    كه منجر به اع ـ     شوند ي طراح رفيت نهايي خود  ظ از   كمتربراي اندكي   افزار    در نرم  ءشود كه اعضا   ين باعث م  يشود و ا   يگرفته م نظر  
  .هاي بالا در مقاطع خواهد شد تنش

را  است افزار نرممنوال  كه طبق طور آن به صورت واقعي افزار را در نرم General  مدل شده به صورتي بتوان نتايج مقاطع طراحكه آنبراي 
 بـراي ايـن   ETABS تـا  ،سازي كنـيم  معادل شكل I به صورت مقاطع را به شكلي Section Designer و GENERAL مقاطع بايد ،مشاهده كرد
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 مقاطع اساس مقطع پلاستيك را ملاك بررسي قرار دهد و با اخذ ضخامت ها و عرض بال و جان بتواند كنترل فـشردگي را روي ايـن مقـاطع                            
  .انجام دهد

 در تيـر هـا دو مقطـع         ،انـد   شـده  طـرح    1براي مقـاطع موجـود در ايـن پـروژه كـه در روش تـنش مجـاز همگـي بـا نـسبت تـنش زيـر                             
IPE270_2PLF200X5 و IPE300_2PLF250X5  مقــاطع جفــت هــا ســتون و در IPE  2 هــاي نــامبــاIPE22 ، 2IPE24 ، 2IPE27 ، 2IPE30 ، 

2IPE240_2PLF280X20_D200 ،2IPE270_2PLF400X25_D290 كه به صورت هستند مقاطعي General   اند شدهتعريف.  

 شـكل وارد و سـپس توسـط         Iبراي اين مقاطع با تعريف ضخامت و عرض بال و جان، مشخصات مقطع مركب را به صورت يك مقطـع                     
 را pro.* تعريـف و فايـل بـا پـسوند      Iرت  را بـه صـو   مقاطع اين 7-3مطابق شكل   Proper V.8-2001 افزار نرمفايل اكسل مجهز به ماژول 

  .سازيم مي
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  Proper افزار نرمشكل و گرفتن خروجي از  Iسازي مشخصات مقاطع مركب به صورت مقطع  معادل ةنحو -7-3 شكل

  :كنيم ميوارد  Import I/Wide Flangeبه صورت  ETABSدر   مقاطع ساخته شد راسپس

  
 
 ءپارامترهاي طراحي اعضا -3-7

  :هاي طراحي تيرپارامتر •
 بـراي پـس از انتخـاب تيرهـا     .كنيم مي را انتخاب  beam ة گزين،Select > by Line Object Typeبراي انتخاب تمامي تيرهاي سازه از دستور 

 چنانچـه مـوردي نيـاز بـه تغييـر مقـدار       ،9-3 مطـابق شـكل   Design > SFD > View/Revise Overwrites از منـوي  ءتغيير مشخصات اعضا
  .كنيم مي تنظميات مربوطه را وارد ،فرض داشته باشد پيش
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  شكل تعريف شده است Iكه به صورت  2IPE240_2PLF280X20_D200مشخصات هندسي مقطع  -8-3 شكل

هـاي جـانبي را بـراي تيرهـا در      گـاه   تكيـه  ة فاصـل  بايد ،بي دارند  تيرها درون سقف قرار گرفته و به طور كامل مهار جان           ةاز آنجا كه در ساز    
ETABS كه از منـوي  9-3ست در شكل  ا براي اين منظور كافي .كرد تصحيح Design > Overwrites Frame Design Procedyre  در جلـوي 
هـاي جـانبي تيرهـا را برابـر مقـدار       گـاه  كيه ت ةپيچشي يا همان فاصل - طول آزاد براي كمانش جانبيUnbraced Length ratio (LTB)عبارت 
  .وارد كنيمرا  0.01 براي مثال ،كوچك

-3 در اشكال بايد ،اي مد نظر باشد  چنانچه ضوابط طرح لرزه .نظر شده است   صرف اي لازم به ذكر است در اين پروژه از ضوابط طرح لرزه          
  . تغيير يابد1.15مطابق مبحث دهم به ندها و بادب ها ستون،  را در تيرها OverStrength Factorضريب 10-3 و 9

فـرض كامپوزيـت طراحـي        لذا بر خلاف تيرهاي دو سر مفصل كه به طور پـيش            ؛هستندهمچنين در اين پروژه تمامي تيرها دو سر گيردار          
  .ارندشوند و نيازي به تغيير نوع طراحي ند  طراحي ميSteel Frame Designشوند، در اين قاب تمامي تيرها از نوع  مي
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  ETABSطراحي تيرها در  مشاهده و تغيير مشخصات ةنحو -9-3 شكل
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  :پارامترهاي طراحي ستون •
هـا   نتخاب سـتون پس از ا. كنيم مي را انتخاب  Column ة گزين،Select > by Line Object Typeهاي سازه از دستور  براي انتخاب تمامي ستون

چنانچه موردي نياز به تغييـر مقـدار   ، 10-3 مطابق شكل Design > SFD > View/Revise Overwrites از منوي ء تغيير مشخصات اعضابراي
  :كنيم مي تنظميات مربوطه را وارد ،فرض داشته باشد پيش

P دوم چنانچه از روش عمومي تحليل      ةبراي لحاظ آثار مرتب    - δ− و P − Δ   ضرايب بايد ،شود مياستفاده B2  وB1  10-3را مطابق شكل 
 ؛ تغيير داد1ها به   ستونةبراي هم

–يت فشاري آنها معيار كمـانش پيچـشي        ممكن است در تعيين ظرف     ، شكل معادل سازي شوند    Iي سازه با مقاطع     ها  ستونچنانچه مقاطع    -

كمانشي در اين گونه مقـاطع   چنين  اصولاً، و بزرگ بودن سختي پيچشيها ستونكه با توجه به جفت بودن مقاطع       حالي در   ،خمشي حاكم شود  
 مربـوط بـه ايـن       مـؤثر  ضـريب طـول      بايـد  ،خمـشي  - ظرفيت فشاري بـر مبنـاي كمـانش پيچـشي           ةبراي خنثي كردن محاسب   . شود  نميايجاد  

 ؛ معرفي شود0.001  مثلاًوچكيك عدد خيلي ك ،LTBKكمانش،

 , Effective Length (K Major بنابراين لازم اسـت ضـرايب  ،هستند طبقات سازه  در دو جهت مهار شده 3-3از آنجا كه مطابق جدول  -

Minor) و Effective Length (K Major , Minor Braced) تغيير يابد1 برابر . 

  :چنانچه در سازه از مهاربند استفاده شود

 2UNP استفاده شود، مقـاطع  2L يا جفت نبشي  2UNPدار براي مثال جفت ناوداني ر براي مهاربندها از مقاطع جفت يا ورقاگ
 براي جلوگيري از حاكم شدن صورت  ايندر  . كنيم  افزار معرفي مي     را با نبشي تك معادل و به نرم        2Lرا با ناوداني تك و مقاطع       

البته اين بـه شـرطي اسـت كـه           . برابر يك عدد خيلي كوچك معرفي شود       LTBKب ضري بايد ، پيچشي - كمانش خمشي   ةضابط
  . پيچشي در اين مقاطع اتفاق نيافتد- كمانش خمشيواقعاً

 تغييـر  1.15مطابق مبحث دهم بـه  ها در بادبند OverStrength Factor ضريب بايد ،اي مد نظر باشد همچنين چنانچه طرح لرزه
  .يابد
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  ETABSها در   مشاهده و تغيير مشخصات طراحي ستونةنحو -10-3 شكل
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 روش حالت حديه نتايج گرافيكي طراحي ب -3-8

Pآنـاليز عمـومي     بـه روش    دوم ةبا تحليل اثر مرتب   روش حالت حدي    ه   ب  شده طراحي مقاطع    نسبت تنش  -الف − Δ    قـاب    و  اول ةطبق ـبـراي
  .نشان داده شده است 11-3 در اشكال 4 ةشمار

 كه نسبت تنش آنها در طراحي به هستندبه روش تنش مجاز در قاب هاي متناظر مقاطع طرح شده مقاطع كنترل شده در روش حالت حدي، 
  .روش حالت حدي مورد بررسي قرار گرفته است
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  روش حالت حديه  ب4 و1قاب  مقاطع در طبقه اول و  طراحينسبت تنش -11-3 شكل




